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Service Software Phoenix
Note: Please refer to the Service Concepts section to check the correct way to connect 

the cables.

Phoenix Installation Steps in Brief
These are the basic steps to install the Phoenix

• Install the Phoenix Service SW
• Install the Data Package for Phoenix (product specific data and flash update 

package)
• Manage connection settings (depends on the tools you are using)
• Update FPS-8 SW (if you use FPS-8)
• Activate FPS-8
• Update JBV-1 Docking Station SW (only when needed)
• The flash update files are delivered with then Phoenix Data Package so unless you 

want to use certain version of this package, separate installation package is not 
needed anymore. If you want to use it, it should be installed after connection 
management, before FPS-8 update.

Please refer to Technical Bulletins for more information concerning phone model 
specific service tools and equipment setup.

Phoenix Service SW

Before Installation 
• Check that a Dongle is attached to the parallel port of your computer.
• Download the installation package (e.g. 

nhl2na_nhm4_nhm7_nhm8_npe4_npl1_npm9_03_72_002.exe) to your com-
puter (e.g. C:\TEMP) 

• Close all other programs
• Run the application file (e.g. 

nhl2na_nhm4_nhm7_nhm8_npe4_npl1_npm9_03_72_002.exe) and follow 
instructions on the screen

• Administrator rights may be required to be able to install Phoenix depending on 
the Operating System

• If dongle driver is installed or updated, you need to reboot your PC before the 
installation can continue.

• If uninstalling or rebooting is needed at any point, you will be prompted by the 
Install Shield program.

If at any point during installation you get this message, “Dongle is not found and instal-
lation can´t continue”, the possible reasons may be a defective or too old PKD-1Dongle 
(five digit serial number Dongle when used with FPS-8 Prommer) or that the FLS-4S POS 
Flash Dongle is defective or power is not supplied by external charger. 

Check the COM/parallel ports used first! After correcting the problem Installation can be 
restarted.
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Startup
Run the nhl2na_nhm4_nhm7_nhm8_npe4_npl1_npm9_03_72_002.exe to start instal-
lation.

When you choose “Next” the files needed for installation will be extracted. Please wait…

If the setup files are already extracted (left in the file system from previous installation) 
following dialog appears. Always click "Yes to All" to overwrite the existing setup files.
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Dongle Driver Installation and Version Check 
If there is no previously installed Dongle driver, installation will take place.

If Dongle driver is installed and it is older than the latest supported version, the latest 
version will be installed when you choose “Yes”. The latest version is always included in 
the latest Phoenix installation package.

PC needs to be rebooted before installation can continue. Click "Yes" to reboot the PC. 

Setup is restarted automatically after reboot. 

First Time Installation of Phoenix
After Dongle driver installation / update (if needed) installation continues from this step.
Click "Next" in Welcome dialog to continue.
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Choose destination folder, it is recommended to use the default folder C:\Program-
Files\Nokia\Phoenix. 

Choose “Next” to continue. You may choose another location by selecting “Browse” (not 
recommended)

Setup copies the components. Please wait. Progress of the setup is shown. Please wait…
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If restarting of your computer is needed the Install Shield Wizard will tell you about it. 

Select "Yes..." to reboot the PC immediately and "No..." to reboot the PC manually. 

Note that Phoenix doesn't work, if components are not registered. Click “Finish” to con-
tinue.

After the reboot components are registered and Phoenix is ready for use.
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If reboot is not needed components are registered after copying them.

If restarting of your computer is not needed, this view will be shown instead.

Click "Finish" to exit the setup. Phoenix is now ready for use.

Now the installation of Phoenix Service SW is ready and it can be used after:

• Installing Phone model specific Phone Data Package for Phoenix
• Configuring the connections 
• Updating the Flash Update Package files used with FPS-8* and FLS-4* tools

Update Installation of Phoenix
If you already have the Phoenix Service SW installed on your computer, sooner or later 
there will be need to update it when new versions are released.

Please note that very often the Phoenix Service SW and the Phone Specific Data Package 
for Phoenix come in pairs, meaning that certain version of Phoenix can only be used with 
certain version of Data Package. Always use the latest available versions of both. Instruc-
tions can be found in phone model specific Technical Bulletins.
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To update the Phoenix you need to take exactly the same steps as when installing it for 
the first time.

• Download the installation package to your computer hard disk
• Close all other programs
• Run the application file (e.g. 

nhl2na_nhm4_nhm7_nhm8_npe4_npl1_npm9_03_72_002.exe)
• Dongle driver version will be checked and if need be, updated 
• After reboot installation starts automatically
• Newer version of Phoenix will be installed

When you update the Phoenix from old to new version (e.g. update from 03.65.00 to 
03.72.002), the update will take place automatically without uninstallation

If you try update the Phoenix with the same version that you already have (e.g. 
03.72.002 to 03.72.002) you are asked if you want to uninstall the version of Phoenix 
you have on your PC. Answer “OK” to uninstall Phoenix, “Cancel” if you don’t want to 
uninstall.

If you try to install an older version (e.g. downgrade from 03.72.002 to 03.55.000) instal-
lation will be interrupted

Please always follow the instructions on the screen.

How to Uninstall Phoenix 
Uninstallation can be done manually from Windows Control Panel - Add / Remove Pro-
grams.

Choose “Phoenix NHL-2NA / NHM-4 / NHM-7 / NHM-8 / NPE-4 / NPL-1 / NPE-9 
Release” click  "Add/Remove". 

Choose “OK” to uninstall
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Progress of the uninstallation is shown.

You might have to reboot the PC after uninstallation.

Note: If you have different product packages installed, components are uninstalled 
only if they are not included in other product packages. 
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Data Package for Phoenix (Product Specific)

Before installation
• Product Data Package contains all product specific data to make the Phoenix 

Service Software and tools usable with a certain phone model.
• It also includes the latest version of flash update package for FLS-4* and FPS-8*
• Check that the Dongle is attached to the parallel port of your computer.
• Install Phoenix Service SW
• Download the installation package (e.g. NHL-2NA_dp_v_3.08.exe) to your com-

puter (e.g. C:\TEMP) 
• Close all other programs
• Run the application file (e.g. NHL-2NA_dp_v_3.08.exe) and follow instructions 

on the screen

If you already have the Phoenix Service SW installed on your computer, sooner or later 
there will be need to update it when new versions are released.

Please note that very often the Phoenix Service SW and the Phone Specific Data Package 
for Phoenix come in pairs, meaning that certain version of Phoenix can only be used with 
certain version of Data Package. Always use the latest available versions of both. Instruc-
tions can be found in phone model specific Technical Bulletins.

Installation of Phoenix Data Package (Product Specific)
Run the NHL-2NA_dp_v_3.08.exe to start installation.

 When you choose “Next” the files needed for installation will be extracted. Please wait…
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Choose “Next” to continue. 

From this view you can see the contents of the Data Package. Read the text carefully. 
There should be information about the Phoenix version needed with this data package. 
Choose “Next”.

Confirm location and choose “Next” to continue. Install shield checks where the Phoenix 
application is installed and the directory is shown. Choose “Next” to continue.
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Phone model specific files will be installed. Please wait

Choose “Finish” to complete installation
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You now have all phone model specific files installed in your Phoenix Service SW.

How to Uninstall Data Package 
Uninstallation can also be done manually from Windows Control Panel / Add / Remove 
Programs/ 

“NHL-2NA Phone Data Package”.

If you try to install the same version of Phoenix Data Package that you already have, you 
are asked if you want to unistall the version you have on your PC. Answer “OK” to unin-
stall, “Cancel” if you don’t want to uninstall. Older versions of data packages do not need 
to be uninstalled. 

Once the previously installed Data package is uninstalled, choose “Finish”. 
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Run the NHL-2NA_dp_v_3.08.exe again to continue installation from the beginning.

How to Manage Connections
Start Phoenix Service SW and Login.

Choose “Manage Connections” From “File” – Menu

Existing connections can be selected, edited, deleted and new ones created by using this 
dialog.
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A connection can be created either manually or by using a Connection Wizard.

To add new connection, choose “Add” and select if you want to create it manually or by 
using the Wizard.

Choose “Next” to continue.

In the next dialogs you will be asked to select some settings for the connection

Manual Settings
A) For FLS-4 POS Flash Device choose following connection settings

• Media: FBUS
• COM Port: Virtual COM Port used by FLS-4 Please check this always!

(To check please go to Windows / Control Panel / FLS Virtual Port / Configuration)
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B) For FPS-8 Flash Prommer choose following connection settings:

• Media: FPS-8
• Port Num: COM Port where FPS-8 is connected
• COMBOX_DEF_MEDIA: FBUS

Choose “Finish” to complete.

If you use the Wizard, connect the tools and a phone to your PC and the wizard will 
automatically try to configure the correct connection,

Activate the connection you want to use by clicking it and use up/down arrows to move 
it on top of the list. Choose “Apply”. The connection is now selected and can be used 
after closing the “Manage Connections” window

Selected connection will be shown on the right hand bottom corner of the screen
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To use the selected connection, connect the phone to Phoenix with correct service tools, 
make sure that it is switched on and select “Scan Product”. 

When Product is found, Phoenix will load product support and when everything is ready, 
name of the loaded product support module and its version will be shown on the bottom 
of the screen.

How to Update Flash Support Files for FPS-8* and FLS-4*

Before Installation
• Install Phoenix Service SW and Phoenix data package 
• Download the installation package (e.g. flash_update_02_06_001.exe) to your 

computer (e.g. C:\TEMP) 
• Close all other programs
• Run the application file (e.g. flash_update_02_06_001.exe) and follow instruc-

tions on the screen
Note: 

• The flash support files are delivered in the same installation package with Phoe-
nix data package.

• Normally it is enough to install the data package only before updating the FPS-8.
• Separate installation package for flash support files is available, and the files can 

be updated according to this instruction.

Installing the Flash Support Files
Start by double clicking flash_update_02_06_001.exe. Installation begins.
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If you already have the same Flash Update package files installed, you need to confirm 

if you want them to be reinstalled. 

Choose “Next” to continue installation

It is highly recommended to install the files to the default destination folder C:\Program 
Files\Nokia\Phoenix. Choose “Next” to continue. You may choose another location by 
selecting “Browse” (not recommended)
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Installation continues…

Choose “Finish” to complete procedure. 

• FLS-4 can be used right after Flash Update Package is installed.
• FPS-8* must be updated by using Phoenix!
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How to Update The FPS-8* Flash Prommer SW
Start Phoenix Service Software.

Select ”FPS-8 / FPS-8C maintenance” from ”Flashing” menu

When new FPS-8 flash update package is installed to computer you will be asked to 
update the files to FPS-8 Prommer. Select ”Yes” to update files. 
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Update procedure takes a couple of minutes, please wait.

Following dialog appears after FPS-8 is updated.
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FPS-8 sw can also be updated by pressing ”Update” button and selecting appropriate 
fps8upd.ini file

Under C:\Program Files\Nokia\Phoenix\Flash - directory

All files can be loaded separately to FPS-8. To do this, just press right mouse button in 
”Flash box files” window and select file type to be loaded.

More information and help can be found from “Help” dialog

FPS-8 Activation and Deactivation
• Before the FPS-8 can be successfully used for phone programming, it must be 

first activated.
• If there is a need to send FPS-8 box to somewhere e.g. for repair, box must be 

first deactivated.

Note: Phoenix should be closed before running BoxActivation.exe.

Activation
Before FPS-8 can be successfully used for phone programming, it must be first activated. 
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Fill in first “FPS-8 activation request” sheet, in the FPS-8 sales package and follow the 
instructions in the sheet. 

When activation file is received (e.g. 00000.in), copy it to C:\ProgramFiles\Nokia\Phoe-
nix\BoxActivation - Directory on your computer 

(This directory is created when Phoenix is installed).

Start BoxActivation.exe from C:\ProgramFiles\Nokia\Phoenix\BoxActivation – directory.

Follow the instructions in the screen.

1 Choose correct COM Port where your FPS-8 is connected
2 Information about the FPS-8 is shown
3 Choose “Activate the Box”
4 Activation file will be shown, check that it is correct 
5 Box will be activated and updated information is shown 
6 Turn FPS-8 power off and on to complete activation

Deactivation
Start BoxActivation.exe from C:\ProgramFiles\Nokia\Phoenix\BoxActivation directory and 
follow the instructions in the screen.

1 Choose correct COM Port where your FPS-8 is connected 
2 Information about the FPS-8 is shown 
3 Choose “Deactivate the Box” 
4 Confirm Deactivation. 
5 Box will be deactivated, please exit BoxActivation
6 Turn FPS-8 power off and on to complete deactivation

JBV-1 Docking Station SW 
The JBV-1 Docking Station is a common tool for all DCT-4 generation products.

In order to make the JBV-1 usable with different phone models, a phone specific Docking 
Station Adapter is used for different service functions.

The JBV-1 Docking Station contains Software (Firmware) which can be updated.

You need the following equipment to be able to update JBV-1 software:

• PC with USB connection
• Operating System supporting USB (Not Win 95 or NT)
• USB Cable (Can be purchased from shops or suppliers providing PC hardware and 

accessories)
• JBV-1 Docking Station
• External Power Supply 11-16V
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Before Installation
• Download Jbv1_update.zip – file to your computer (e.g. C:\TEMP) from your 

download web site.
• Close all other programs
• Follow instructions on the screen

Installing SW Needed for the JBV-1 SW Update
Note: DO NOT CONNECT THE USB CABLE / JBV-1 TO YOUR COMPUTER YET!

Run Jbv1_update.zip file and start SW Installation by double clicking Setup.exe. 

Files needed for JBV-1 Package setup Program will be extracted.

Installation begins, please read the information shown and Choose “Next” to continue

Use suggested destination folder where JBV-1 SW Package will be installed and

Choose “Next” to continue
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Select “Full” Installation and choose “Next” to continue

Program Folder will be created. Choose “Next” to continue, Software files will be 
installed
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After successful installation, choose “Finish” to complete.

NOW YOU CAN CONNECT THE USB CABLE / JBV-1 TO YOUR COMPUTER

Connect power to JBV-1 (11-16V DC) from external power supply, then connect USB 
Cable between JBV-1 USB connector and PC.

Windows will detect connected USB cable and detect drivers for new HW.
Please follow the instructions and allow Windows to search and install the best 
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Drivers available. After this procedure the actual JBV-1 SW update can begin.

Updating the JBV-1 Docking Station Software
Go to folder C:\Program Files\Nokia\ JBV-1 SW Package\ FIRMWARE UPDATE and start 
JBV-1 Update SW by double clicking   fwup.exe.

JBV-1 Firmware update starts and shows current status of the JBV-1 connected.

If firmware version read from your JBV-1 is not the latest one available, it needs to be 
updated by choosing “Update Firmware”

Choose file JBV1v11.CDE (example used here is for v 11) and “Open” to update your JBV-1
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After successful update, current JBV-1 status will be shown. You have now updated the 
software of your JBV-1 docking station and it is ready for use.
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SW update flashing setup 

Equipment list
The following equipment is need for NHL-2NA AMS SW update:

Figure 1: Setup for flashing 

List of equipment:

Connecting NHL-2NA to PC with FPS-8, list of equipment which is needed:

Item Description Type Code

1 Point of Sales flash loading adapter FLA-21 0775284

2 power cable FLC-2 0730185

3 Modular cable               XCS-4 0730178

4 Flash prommer box sales pack FPS-8 0080321

5 Printer cable AXP-8, incl in FPS-8 sales pack

6 D9 – D9 cable AXS-4, incl in FPS-8 sales pack 0730090

7 Software protection key PKD-1 0750018

8                   AC Charger, incl in FPS-8 sales pack 0680032

9 SRAM Module (2 pcs needed inside 
FPS-8)

SF12 0080346 (Code includes 
one SRAM module)
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Figure 2: SRT-4 Opening Tool, upper part

Figure 3:  SRT-5 Opening tool, lower part

Item Description Type Code

fig. 2 Opening Tool SRT-4 0770286

fig. 3 Opening Tool SRT-5 0770444
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Flashing Instructions

Connecting phone to Service accessories
The purpose of this document is to guide you through NHL-2NA SW update in case you
have set up the FPS-8 or FLS-4S SW update place according to instructions in previous
chapters.

Opening phone for SW update
Nokia 7650 does not have any external data connectors and mechanical solution limits
the number lines between keyboard part and transceiver part. To get access to FBUS and
MBUS flash connectors Nokia 7650 must be opened with special tools called SRT-4 and
STR-5.

Opening procedure is as follows:

7 Place the phone grip opened onto lower tool cavity upside down.
8 Install upper part on the lower part so that the nails are in the phone tracks.
9 At the same time put the upper part guides to the lower part grooves.
10 Push the upper part till end of the grooves.
11 Push the upper part back to the starting point.
12 Remove the upper part.
13 Take the phone out of the tool.

Figure 4: Instructions for use of STR-4 and SRT-5 opener.
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After this you should be able to see FBUS and MBUS pads as follows:

Figure 5: FBUS and MBUS pads visible when Phone has been opened to service position.

Once you have phone open like this, you can connect it to FLA-21 POS flash adapter.
Some precautions should be taken as phone is not in standard use position:

Warnings:

Warning 1. Do not detach the grip part totally from transceiver part if you have not 
been trained for that. Parts are interconnected with flex foil which can be damaged 
and after that phone can be repaired only with special tools.

Warning 2. If the grip part jumps slightly out of tracks when you are opening the 
phone, gently snap grip part back on its place.

Connecting phone to FLA-21 adapter
The following pictures show you the correct way to connect Nokia 7650 Phone to FLA-21 
POS flash adapter.

1 First connect battery connector to FLA-21.

Figure 6: Connect battery connector to FLA-21:
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2 Snap FLA-21 and Nokia 7650 together so that plastic nails in FLA-21 go into 
tracks in Nokia 7650.

Figure 7: Connecting FLA-21 to Nokia 7650 so that plastic nails attach firmly into tracks.

3 Connect rest of the cables for FLS-4S or FPS-8 SW update as illustrated earlier.

SW updating
IMPORTANT! Nokia 7650 will most likely have two kinds of data packages. 

1 SW releases which have only minor modifications in user data area. These pack-
ages do not format user data area. For this reason the user does not need to be
read out from the device and does not need to be written back.

2 SW releases which have modifications in user data area. If this kind of SW
release needs to be done, it will be clearly indicated in the Technical bulletin and
Service bulletin that this package will automatically format user data. With this
kind of SW release it is mandatory to backup all user data before SW update and
restore it back to customers device after SW update.

Steps through SW update
Start now Phoenix SW by double clicking Phoenix icon on your desktop.

Note! These instructions assume that you have configured buses from Manage Con-
nections menu as advised earlier in this service manual. From Manager connections
you can select the correct connection for the Flashadaper FLS-4S or FPS-8. 

SW starts and shows you ‘no product’ text in the bottom of the screen. Product needs
now to be scanned by choosing File -> Scan product as shown below:
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Figure 8: Scanning product with phoenix

If scanning is successful, you will see ‘no procut in the bottom of the screen to change 
into ENOS SW version inside the phone.   See below:

Figure 9: Phone replied correctly to Product scan

As phone is now correctly connected to FLS-4S or FPS-8 and scanning was successful, 
You can start SW update from Flashing menu.

Choose Flashing -> FLS-4 Flash (If you are using FLS-4S)

Choose Flashing -> FPS-8 Flash (If you are using FPS-8)

The following window will open:
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Figure 10: Choosing correct files for SW update and marking Save settings box if necessary

Phoenix SW now automatically reads the Product code which is stored electronically 
inside the phone and picks the files which are associated to this product.

IMPORTANT:

Depending on weather the data package you have received automatically erases the
user area or not, you have to check save settings box correctly. Otherwise all cus-
tomer user data will be lost. Automatic erasing will be clearly stated tin the technical
bulletin of the SW if this kind of SW will be published.

If Technical bulletin says that used data area is not automatically formatted, do not
mark Save settings box.

If Technical bulletin says that data package automatically formats user area, you
must mark ‘Save Settings’ box.

Note: What is user area format? We have thought on behalf of you when user area
format must be used when updating SW. If data package automatically formats user
area it is clearly stated in the release note of the SW. User area format removes all user
generated data from the phone. If data package automatically formats user data, you
must save the User data before SW update.

Choose now Flash and you will see the following dialogue box
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Figure 11: Choosing the correct product code

Usually the electronic product code inside the device gives you the correct files to update 
into the phone. There is one exception to this rule. Exchange units can be updated with 
other SW than the one mentioned in the product code field. 

Alternatives:

• In normal customer SW update case just press OK and SW update starts. 

• In case you are updating the exchange unit to give it to the customer, choose 
from the product code list the variant customer has. It has to be the same which 
was in the original device of the customer. See Appendix in the end for this doc-
ument for further info in Exchanging customers phone.

If you chose to save settings you will see the following windows as all customer settings
and all user data is saved.

Figure 12: Saving settings progress bar.

Figure 13: Window where you can see that all used data has been successfully saved.
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When SW update starts, you can see as Phoenix erases Core package memory area:

Figure 14: Phoenix erasing phone memory

And after this you can see as Phoenix programs new SW package into the phone.

Figure 15: Phoenix programming phone memory

You will see two erases and two programmings as first core package area is erased and
programmed and then language package area is erased and programmed. 

Programming has ended when you see the following dialogue:

Figure 16: End of programming dialogue.

Now press phone’s power key and wait until you see ‘insert sim card’ - text on the
phones screen. Click OK with mouse. You will see some final operations in Phoenix win-
dow rolling on the screen

If you clicked on save settings box when you started SW update, you will now in this
stage see as all user settings and all used data is loaded back to phone:
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Figure 17: Loading all user settings and all user data back to phone

And finally when all files have been loaded back to phone, the following dialogue box 
appears: 

Figure 18: SW update completed successfully.

Press now ok, wait until scrolling on the screen stops and detach you phone from FLA-21
as follows:

Figure 19: Detaching phone from FLA-21

Close now the phone into normal use position and insert SIM card and battery. Boot the
phone up and see that all the user data has been restored correctly and check the SW
version by typing *#0000# on the telephone application.
Issue 1 07/02 �Nokia Corporation Page 37



NHL-2NA
CCS Technical Documentation
Appendix A, Exchanging (Swapping) customers phone
In case customer’s phone is so badly damaged that you have to give him/her exchange
unit, the following instructions should be followed.

Checking and updating exchange unit
Take exchange unit from its package and see which SW and language version it has. If it
does not match the customers phone or SW version inside it is older than the newest one
available, update it to the news SW available and update it with the language version
which is identical with customers phone. Choose language from product code filed as
illustrated in Fig 7. earlier in this document.

Reading data from customers phone
Now take customers phone and try to read user data out from it if possible. Use of Phoe-
nix recommended. PC suite can also be used but PC suite does not take backup of Midi
ringing tone and java applications. In case customer has those in phone they will be lost
during the operations.

This document describes exchanging only with Phoenix SW.

Reading data from customers phone

Connect customers phone to FLA-21 and phoenix as described earlier in this document.

Scan the product and choose Product -> user settings -> All settings as follows:

Figure 20: Saving user settings from customers phone when exchanging the unit. 

The following dialogue will open:
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Fig 17. Saving customers settings and used data when exchanging unit.

All data is selected by default.

Note! Maximum amount of data in Nokia 7650 is 4 Mbytes and exchange transfer is
quite slow. It is advisable to ask customer to empty any unnecessary files from his/
hers device before the exchange is started to speed up the process.

Now press ‘Save’ button and all data in the customers data is saved to PC hard disk.

When operation has finished, all status field go to OK status and you get the following
note:

Figure 21: All user data from customers defective device has been successfully saved to PC hard disk
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Now detach defective device from FLA-21 and attach exchange unit with newest SW 
and correct language version.

Choose File -> Close product and then File -> Scan product. 

Choose User settings -> all settings as in figures 16 and 17.

Now choose Load and load all the data you just red from the defective device to the 
exchange unit.

When the operation is complete, detach the phone from FLA-21, boot it up with SIM 
card and battery and see that SW version is the newest one and that all customer data 
has been correctly restored.
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Energy Management Calibration

Baseband Tunings

Energy Management Tuning
• External power supply needed
• EM Calibration is used for calibrating Battery and Charger settings of the phone.
• Preparation for EM Calibration:

•- Connect DC Cable SCB-3 between JBV-1 and Vin of Phone for Charger 
calibration.

•- Connect 12…15 V from Power Supply to JBV-1.
•- NOTE! Check that connection is F-BUS (doesn't work with M-BUS!).

• Select Maintenance => Tuning => Energy Management Calibration

• Energy Management values to be calibrated are checked
• Select “Read from Phone” to show current values in phone memory and to check 

that the communication with phone works
• Select “Calibrate” to run selected calibrations
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Limits for Energy Management Calibration:

• If values shown are within limits select “Save To Phone” to save values to phone.
• NOTE! Only values of checked tunings (Battery size, Battery Temperature etc.…) 

will be saved.
• Close the “Energy Management Calibration” – dialog to end tuning

Sensor calibration instructions

Proximity Detector Calibration

General
Three parameters are calibrated in proximity sensor calibration: Gain, Detection thresh-
old and Fault detection threshold. Calibration must be done always when emitter,
receiver, AEM or proximity optics have been replaced.

Calibration is done in two phases. First detection threshold and gain are calibrated. If

                           Min       Max
 

ADC gain 25400     29000 
  DC offset -50        50 
  BSI gain 860          1180   
  BTEMP gain 1980 2450  
  VBAT gain 10000 11000 
  VBAT offset 2300 2700 
  VCHAR 58000 62000 
  ICHAR 4000 4800  
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this is done successfully, fault detection threshold is calibrated.

Start values for calibration are defined by NMP. Using correct start values is necessary
for successful calibration. At Nokia Mobile Phone’s request, Start values can be changed
by editing nhl2pxm.ini file in \Phoenix\Products directory. Start values in nhl2pxm.ini can
be taken into use by pressing Use defaults-button.

Tools
• MJF-7 with 20% diffuse reflectance target. 

Note: In troubleshooting purposes the calibration can be done also in other test jigs 
and without standard target, but those calibrations never replace calibration with 
MJF-7. 

• Phoenix with ‘Proximity Sensor Calibration’-tool.
• The figure below shows the correct setup for proximity detector calibration.

Figure 1: Proximity Detector Calibration Setup

Calibration
• Start ‘Proximity Sensor Calibration’-tool: Maintenance -> Tuning -> Proximity 

Sensor Calibration. Values in the phone permanent memory are read automati-
cally from phone memory, when calibration tool is started.
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Figure 2: Proximity Sensor Calibration dialog with start values

The Proximity Detector Calibration Setup figure shows the Proximity Sensor Calibration
tool. Gain, Detection threshold, and Fault threshold in the left column are the values in
phone permanent memory. Middle column shows start values that are used in the cali-
bration. They are defined by Nokia Mobile Phones, and should not be changed without
Nokia Mobile Phones request. 

Note! Values in the Figure 2 are not correct after 06/2002.

• Default start values (06/2002) are Gain 7, Detection threshold 4, Detection offset 
1, Fault threshold 3 and Fault offset –2.

• Press Start to start the calibration, and follow instructions. At first Phoenix ask 
you to place the reflectance target above the proximity lenses. Calibration may 
be done only with 20% reflectance target (size 50mm*50mm, distance from the 
lenses 50mm). Use only Nokia accepted calibration target that is provided with 
MJF-7.

• After successful detection/gain calibration Phoenix asks you to remove the cali-
bration target for fault detection threshold calibration. Make sure, that there is 
at least 1500mm free space above the phone. 

• If something has gone wrong in the calibration, return message gives valuable 
information for error hunting. From Help menu you can find some indication of 
the fault, more detailed information is found in the baseband troubleshooting 
document. In the figure Error message after failed calibration you can see the 
error message after failed fault threshold calibration, it is FAULT_OVER_LIMIT. 

• Message after successful calibration is in the figure Return message when cali-
bration was successful. 
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Figure 3: Error message after failed calibration

Figure 4: Return message, when calibration was successful

• Calibration result is shown in the right column of Proximity Sensor Calibration
dialog (Figure Proximity Sensor Calibration dialog with start values). Press ‘Save
to phone’ to save calibration result. After successful saving of calibrated values,
you get the message in Figure Return message after successful saving of calibra-
tion result. With ‘Read’ button you can double-check that saving the values has
succeeded. Note that offset values defined in the middle column are now added
to the detection threshold and fault detection threshold. 
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Figure 5: Return message after successful saving of calibration result

Ambient Light Detector Calibration

General
Ambient Light Detector calibration is based on comparison between reference value and
ADC-reading from the calibrated phone. Calibration is done by illuminating the phone
with a white LED light source, TDS-11. Reference value is read from a Golden Phone. 

Reading reference value with a Golden Phone is called System Calibration. Most impor-
tant for successful calibration is, that System Calibration is done in the same lightning
conditions, where calibration is done. To make sure, that lighting conditions are identical,
calibration must be done in darkness. This can be achieved for example by covering MJF-
7 and TDS-11 with a cardboard box. 

Only if the Golden Phone is not available, a default reference value that is provided with
TDS-11 can be used. 

Tools
• MJF-7 with white LED light source (TDS-11 Calibration lamp, 0770440). 

Note that the supply voltage to JBV-1 has to be precisely 14.0 Volts. This has effect on 
TDS-11 brightness despite the 12 V regulation in TDS-11 output.

• Phoenix with ‘Ambient Light Detector Calibration’-tool. Picture of calibration 
tool is in the figure Ambient Light Detector Calibration Dialog.

• The Figure 7 Ambient Light Detector Calibration Setup shows the Ambient Light 
Detector Calibration Setup.
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Figure 6: Ambient Light Detector Calibration Setup

System Calibration
System calibration must be done always, when:

• Calibration light source has been changed

• After ~1000 calibrations or once a month

System calibration is done with a Golden Phone provided by NMP. Only if the Golden
Phone is not available, default reference value provided with TDS-11 can be used.

• ‘Start Reference Value’ tells the reference value that has been read from a Golden
Phone. System calibration changes this value, and it needs to be done if lighting
conditions have changed. When you are doing the calibration for the first time,
start reference is 0 and system calibration has to be done.

System calibration procedure is following.

• Attach Golden Phone to the MJF-7.

• Start ‘Ambient Light Detector Calibration’-tool: Maintenance -> Tuning ->
Ambient Light Detector Calibration

• Press ‘System Calibration’ and follow instructions. Choose System Calibration
with Golden Phone always, when Golden Phone is available.

• New reference value will be used until next System Calibration. Calibration light-
ning conditions may not change after this.

• Only if Golden Phone is not available, choose ‘Change Reference Value manually’.
Then enter the default reference value that is provided with TDS-11 light source. 
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Calibration
• Save calibration values from phones permanent memory before starting calibra-

tion. 

• Start ‘Ambient Light Detector Calibration’-tool: Maintenance -> Tuning -> 
Ambient Light Detector Calibration.

Figure 7: Ambient Light Detector Calibration Dialog

• Place calibrated phone to the MJF-7 and press ‘Phone’. If the calibration was
successful, calibrated value is shown in the middle box ‘Correction Coefficient’.
Press ‘Write’ to save the value to the phone. AD value in the lowest edit box is
just for your information. 

• CC is 1, if calibrated phone behaves exactly like the Golden Phone. Normally the
value is between 0.75 and 1.25. If value is not between 0 and 8, you will get an
error message. 
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RF-Tuning Instructions (with Phoenix)

General
RF tunings should be made in the same order as shown in this section.

If baseband tunings are needed, they should be made before the RF tunings

Avoid unnecessary tuning – factory tuning values are always the most accurate ones.

Views in this document may change as the service software is developed. Please refer to
the Phoenix help files, phone model specific service manual and bulletins for help.

Service Tool Concept for RF Tunings 
• All RF tunings should be carried out using in MJS-9Q (module jig), TDS-10 (RF-

probe) or RA-7 (RF-adapter)

• CPL-5 coupler can only be used for testing, NOT for tuning!

• Power to MJS-9Q or to JBV-1 should be supplied from an external DC power sup-
ply, not FPS-8 prommer

• MJS-9Q maximum input voltage is +9 V DC, nominal input for RF tunings is +6V 
DC

• TDS-10 and RA7 needs MJF-7 (docking station adapter) in JBV-1 (docking sta-
tion). JBV-1 input voltage is +14 V DC

• Remember cable and jig attenuations when setting required RF levels

Figure 8: Module jig MJS-9Q and other equipment for NHL-2NA RF tuning.
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Figure 9: RF-connection TDS-10 and other equipment for NHL-2NA RF tuning

Note: RA7 can be used instead of TDS-10. RA7 replaces the antenna module, thus 
it’s use requires opening 4 antenna screws in order to place RA7 to the phone.

Item: Service accessory Product code

1 Module jig MJS-9Q 0775284

2 DC power cable PCS-1 0730012

3 RF antenna cable XRF-1 0730085

4 Service MBUS cable DAU-9S 0730108

5 Software protection key PKD-1 0750018

Item: Service accessory Product code

1  JBV-1, Docking station 0770298

2 MJF-7, Docking station adapter 0775285

3 TDS-10 GSM RF Probe for RF tuning 0770436

4 TDS-11 Calibration lamp Not needed in RF-tuning 0770440

5 XRF-1, RF antenna cable 0730085

6 PCS-1, DC power cable 0730012

7 DAU-9S, Service MBUS cable 0730108

8 PKD-1, Software protection key 0750018
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Item: Service accessory Product code

- RF adapter for NHL-2NA RA7 0770443
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Receiver tunings

RX Channel Select Filter Calibration
• Extra equipment / external RF signal not needed

• Must be done before other RX calibrations

• This function is used to calibrate RX channel select filter in GSM Phones.

• Rx Channel select filter is tuned only in one band = Single calibration for both 
bands

• Select Maintenance => Tuning => Rx Channel select filter calibration

• Select “Yes” to start tuning with values already saved to the phone

• Press "AutoTune" to start the tuning
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• Tuning values should be 0…31

• Select “Stop”

• If values shown are within limits, choose “Yes” to save values to the phone save 
them to phone.

• Close the “RX Channel Select Filter Calibration “– dialog to end tuning
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RX Calibration
• RF generator needed 

• This tuning performs RX Calibration 

• Must be done separately on both bands!

• Start RX Calibration at EGSM (GSM900), then do RX Calibration at GSM1800 
band.

• AFC tuning is done while EGSM (GSM900) band RX Calibration is performed.

• Remember to take jig and cable attenuations into account!

• Select Maintenance => Tuning => Rx calibration

• When RX Calibration has been started, you can choose the correct band from the 
dropdown menu. Begin tuning from EGSM 900 band.

• Press "Start" 
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• Select “Default” to start tuning from factory default values => OK

• Set the Calibration mode to “Automatic”

• Press "Calibrate" 

• Set RF generator to required frequency => OK
Issue 1 07/02 �Nokia Corporation Page 15



NHL-2NA
CCS Technical Documentation
Tuning values and ADC readings will be shown

Typical values and limits in (GSM900) RX Calibration: 

EGSM (GSM900) Typical value Limits

AFC value -176 -350…+350
AFC slope 269 150…350
RSSI0        74 67…77
RSSI1         84 77…87
RSSI2         94 87…97
RSSI3         99.5 94…104
RSSI4         109.5 104…114
RSSI5         119.5 114…124
RSSI6         129.5 124…134
RSSI7         139.5 134…144
RSSI8         149.5 144…152

• Choose “Stop” to end tuning 

• If values shown are within limits, choose “Yes” to save values to the phone 

• Continue tuning from GSM1800. Choose the correct band from the dropdown 
menu. 

• Press "Start" to continue just like in the EGSM900 Band above.
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When asked, set RF generator to required frequency => OK

Typical values and limits in (GSM1800) RX Calibration:

GSM1800 Typical value Limits

RSSI0        66.5 63…73
RSSI1         76.5 73…83
RSSI2         86.5 83…93
RSSI3         99.5 94…104
RSSI4         109.5 104…114
RSSI5         119.5 114…124
RSSI6         129.5 124…134
RSSI7         139.5 134…144
RSSI8         149.5 144…152.5

• Choose “Stop” to end tuning 

• If values shown are within limits, choose “Yes” to save values to the phone 
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• Close the “RX – Calibration – dialog to end tuning
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RX Band Filter Response Compensation
• RF generator needed

• Must be done separately on both bands!

• Start RX Band Filter Response Compensation at EGSM (GSM900), then do RX 
Band Filter Response Compensation at GSM1800 band.

• Note: Remember to do RX calibration before doing Rx Band Filter Response Com-
pensation!

• Remember to take jig and cable attenuations into account!

• Select Maintenance => Tuning => Rx band filter response compensation

• Select “Yes” to start tuning with values already saved to the phone

• Select "Manual tuning" 
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• You will be asked to supply 9 different RF frequencies to the phone

• Set first required frequency and level => OK

• Set 2nd required frequency and level => OK

• Set 3rd required frequency and level => OK
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• Set 4th required frequency and level => OK

• Set 5th required frequency and level => OK

• Set 6th required frequency and level => OK

Set 7th required frequency and level => OK
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Set 8th required frequency and level => OK

Set 9th required frequency and level => OK

Typical values and limits in Rx Band Filter Response Compensation EGSM900:

Channel Input frequency (MHz) Measured level difference (dB) Limits (dB)

965 923.26771   -0.118 -10…+5
975 925.26771    0.511  -5…+5
987 927.66771    0.857  -5…+5
1009 932.06771    1.174 -5…+5
37 942.46771    0.569 -5…+5
90 953.06771    1.928  -5…+5
114 957.86771    0.964   5…+5
124 959.86771   0.545 -5…+5
136 962.26771    -0.040  -10…+5

• Choose "Stop, write to PM area" 
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• If values shown are within limits, choose “Yes” to save values to the phone

Continue tuning from GSM1800. Choose the correct band from the dropdown menu.

• Repeat the same steps as for the EGSM900 band above

Typical values and limits in Rx Band Filter Response Compensation GSM1800:

Channel Input frequency (MHz) Measured level difference (dB) Limits (dB)

497 1802.26771    0.214  -10…+5
512 1805.26771    1.739  -5…+5
535 1809.86771   2.056  -5…+5
606 1824.06771    1.632  -5…+5
700 1842.86771    0.583  -5…+5
791 1861.06771    0.734  -5…+5
870 1876.86771    0.616  -5…+5
885 1879.86771    0.185 -5…+5
908 1884.46771    -1.132  -10…+5

• If values shown are within limits, save values to the phone

• Close the “RX Band Filter Response Compensation” – dialog to end tuning
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RX AM Suppression
• RF generator needed (AM modulation)

• Must be done separately on both bands!

• Start RX AM Suppression at EGSM (GSM900), then do RX AM Suppression at 
GSM1800 band.

• This dialog performs RX AM Suppression.

• Remember to take jig and cable attenuations into account!

• Select Maintenance => Tuning => Rx Am suppression

• Start => Default settings => OK,
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• Set RF generator to state described in left-side window. 

• Set the Tuning mode to “Automatic”

• Press the “Tune” button to perform actual tuning. 

• The new tuning values and Rssi dBm value are updated.

• One "I" and "Q" line values sold be 0, other values 0..31

• RSSI level should be around -107 dBm
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• If values shown are within limits, Select “Stop”

• Choose “Yes” to save values to the phone

• Continue tuning from GSM1800. Choose the correct band from the dropdown 
menu. 

• Repeat the same steps as for the EGSM900 band 

• If values shown are within limits, choose “Yes” to save values to the phone

• Close the “RX AM Suppression” – dialog to end tuning
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Transmitter Tunings

TX I/Q Tuning
• Spectrum analyzer needed

• Tx IQ Tuning allows changing the Tx I DC Offset, Tx Q DC Offset, Amplitude dif-
ference and Phase difference

• Must be done separately on both bands!

• Start TX I/Q Tuning at EGSM (GSM900), then continue at GSM1800 band.

• Remember to take jig and cable attenuations into account!

• Select Maintenance => Tuning => Tx_IQTuning

• Select "Load from product" => Start

• The tuning is done by setting each of the sliders to desired value. The sliders can 
be changed only when the tuning is ongoing.

• The order of tuning should be same as the order of the sliders e.g. the Tx I DC Off-
set is tuned first and Phase difference is tuned last.

• Use <=, =>, PgUp or PgDn keys
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• Set spectrum analyzer center frequency to 897.4 MHz, span 200kHZ, RBW and 
VWB 3kHz and sweeptime to 2 seconds

• Tune LO leak to minimum with TXI/TXQ DC offset control (f0 on spectrum ana-
lyzer screen)

• Tune wrong sideband to minimum using Amplitude/Phase difference controls 
(f0+68kHz on spectrum analyzer screen)
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Typical TX Iq Tuning Values and tuning limits GSM 900:

I DC Offset -2.5…+0.5 -6…+6
Q DC Offset -2.5…+0.5 -6…+6
Amplitude difference -0.2…+0.2 -1…+1
Phase difference 88.0°….92.0° 80°…100°

• If values shown are within limits, check the "Save to product" tick box and 
choose “Stop” save the new values to the product 

• Continue tuning from GSM1800. Choose the correct band from the dropdown 
menu. 

• Repeat the same steps as for the EGSM900 band

• Set spectrum analyzer center frequency to 1747.8 MHz, span 200kHZ, RBW and 
VWB 3kHz and sweeptime to 2 seconds
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Typical TX IQ Tuning Values and tuning limits GSM1800:

I DC Offset -3.0…0.0 -6…+6
Q DC Offset -1.5…+1.0 -6…+6
Amplitude difference -0.5…+0.0 -1…+1
Phase difference 90.0°…97.0° 80°…100°

• If values shown are within limits, check the "Save to product" tick box and 
choose  “Stop” save the new values to the product 

• Close the “TX I/Q Tuning” – dialog to end tuning
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TX Power Level Tuning
• Power Meter with peak power sensor (or Spectrum analyzer) needed

• With Tx Power Level Tuning, the coefficients are adjusted for each power level

• Must be done separately on both bands!

• Start Power Level tuning at EGSM (GSM900), then continue at GSM1800 band.

• In EGSM900 band The power level tuning is made for both high and low PA 
Modes 

• In GSM1800 band only for high PA mode. 

• Maintenance => Tuning => Tx power level tuning

• Remember to take jig and cable attenuations into account!

• Select “Start” => “Load from: Permanent memory” => “OK “

• Note that TX PA mode is “High” at this point.
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• The coefficient table lists the power level, coefficient, target dBm and DAC value 
for each power level. 

• The tuned power level can be chosen by using up and down arrows or mouse.

• The current power level is shown with inverse colors.

• The tuning value can be adjusted with “-“ and “+” keys

• Tune base level and power levels 19,15 and 5 to target level 

• Press "Calculate coefficients" 

• Change TxPA Mode to “Low“ from the drop down menu. When the PA Mode is 
changed, the previous values are saved in memory and the ones for new mode 
are shown
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• Tune power levels 19, 15 and 7 (Levels 5 & 6 are not used, base level tuning not 
needed) 

• Press "Calculate coefficients" 

Typical values: EGSM900

Power level PA high mode PA low mode

       5 0.700…0.750          -
       7          -  0.530…0.570
     15 0.190…0.210 0.190…0.210 
     19 0.170…0.180 0.170…0.180
      Base 0.140…0.150 0.140…0.150

• If values shown are within limits select “Stop” and check “Save values to phone 
permanent memory”

• Select “Yes” to save values to phone

• Continue tuning from GSM1800. Choose the correct band from the dropdown 
menu.
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• Repeat the same steps as for the EGSM900 band above

• Note that In GSM1800 band PA mode can not be changed because tuning is only 
made in “High” mode

Typical values: GSM1800

Power level PA high mode

       0 0.620…0.670
       11         0.170…0.190
       15 0.150…0.170
      Base 0.140…0.150

• If values shown are within limits select “Stop” and check “Save values to phone 
permanent memory”

• Select “Yes” to save values to phone

• Close the “TX Power Level Tuning” – dialog to end tuning
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Service Concepts

New Service Accessories for NHL-2NA
PART NO PG PART NAME
0775285           67 MJF-7 Docking station adapter (Does not include CPL-5 RF coupler)
0770370           59 CPL-5 RF coupler
0770443           60   RA7 RF Adapter for NHL-2NA (Screw connection) 
0770436            640 EUR TDS-10 GSM RF probe for RF tuning
0775284            620 EUR MJS-9Q module Jig
0775283            60 FLA-21 POS adapter (Single unit, no cables included)
0770286            48 SRT-4 Opening tool (upper part)
0770444            48 SRT-5 Opening tool (lower part)
0770439            60 MJS-79 Soldering jig. Holds phone PWB in automatic soldering      

machines
0770440            79 TDS-11, Calibration lamp. Ambient light sensor calibration lamp.
N.A N.A. Flex soldering head made by Metcal. Order info in Service manual

Spare parts for service accessories
PART NO PG PART NAME
0770335           58   JBS-28, Uniform light source module (Used in camera tests, one piece 

included in MJF-7. Spare module can be ordered with this code)
0770437           31 Ground pin, TDS-10 Accessory
0770438           52 Insulated antenna pin, TDS-10 accessory
0770497 N.A. SRT-8 pin insertion tool for TDS-10 (Price will be announced later)

MJS-9Q, MJF-7 and FLA-21 Spare pin codes will be announced later with a technical 
bulletin.

Service tools used with other NMP products, but needed also for NHL-2NA
PART NO PG PART NAME
0730108         49 MBUS Cable DAU-9S to connect PC to service tools
0730218         46 XCS-1, SERVICE CABLE (POS flash cable) 
0730178         42 Service Cable XCS-4 (to interconnect FPS-8 and JBV-1/ FLA-21). Mod 10 to 

mod 10 shielded cable with one separately shielded conductor (MBUS/SCK). 
0730012         43 Power Supply Cable PCS-1 for JBV-1 and MJS-9Q
0730114         31 Service Battery Cable SCB-3. Needed for EM-calibrations
0080321 800 EUR FPS-8, Flash Prommer sales pack, incl. Parallel cable, AXS-4, AXP-8 and ACF-8 

power supply 
0080396 8000 EURFPS-8C Parallel Flash Prommer
0080346 72 SF12 SRAM Module (2 pcs needed inside FPS-8, Code includes one piece)
0750018 56 PKD-1 Software protection key
0770431 48 SRT-6 Opening tool
0730085 46 XRF-1, RF antenna cable
0081490 64 JBT-9, Bluetooth test box including SMA stub antenna
N.A. ACP-8, Power supply for JBT-9
0730185          42 FLC-2, Power Supply Cable to interconnect FPS-8 and FLA-21
0770298          70 JBV-1, Docking Station
0080541          71 FLS-4S, POS Flash dongle, for E/A area
0080542          71 FLS-4S, POS Flash dongle, for APAC area
0080465         65 LRK-1, LGA rework kit, sales package incl. 0770349 MJS-54, LGA RE-

WORK JIG, 0770348 SES-1, STENCIL LGA RE-WORK JIG and 0770381 SPS-1, 
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SOLDERING PASTE SPREADER
0770380          49 SPI-1, SOLDERING PASTE INJECTOR, NOTE shelf life only 1 month

Prices and price groups are subject to change without notice.

Service accessory warranty
Service Accessories have 24 months (JBV-1, MJF-7, CPL-5, FLA-21, SRT-4, SRT-5, TDS-10,
TDS-11, RA7 and FPS-8 made by PKC Group or Flextronics) and 30 months (MJS-9Q,
MJS-79 and LRK-1 made by Sorv-Elektro Oy) warranty period and the Vendors' duty is to
repair Accessories also after the warranty.

It is also agreed that Vendors will deliver needed components to you in case you want to
repair ServAccs by yourself after the warranty.)
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Setup Instructions

NHL-2NA SW Update Using FPS-8 and FLA-21
Figure 1: NHL-2NA SW update using FPS-8. Opening tools SRT-4 and SRT-5 are not in the picture.

Table 1: Connecting NHL-2NA to PC with FPS-8, list of equipment which is needed

Item: Service accessory Product code

1  Point of Sales flash loading adapter FLA-21 0775283

2 Power cable FLC-2 0730185

3 Modular cable XCS-4 0730178

4 Flash prommer box sales pack FPS-8 0080321

5 Printer cable, incl in FPS-8 sales pack AXP-8 Not available

6 D9 – D9 cable, incl in FPS-8 sales pack AXS-4 0730090

7 Software protection key PKD-1 0750018

8 Power supply, incl in FPS-8 sales pack ACF-8 0680032

9 SRAM Module (2 pcs needed inside FPS-8) SF12 0080346 (Code 
includes one SRAM 
module)

Not in pic-
ture

Service SW N.A.

Not in pic-
ture

Opening tool (upper part) SRT-4 0770286

Not in pic-
ture

Opening tool (Lower part) SRT-5 0770444
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NHL-2NA SW Update in Point of Sales
Figure 2:  NHL-2NA SW update using FLS-4S. STR-4 and SRT-5 not in picture.

Table 2: NHL-2NA POS flash equipment list:

Item: Service accessory Product code

1 Point of Sales flash loading adapter FLA-21 0775283

2 Service cable XCS-1 0730218

3 Power supply ACF-8 0680032

4 POS flash dongle, for E/A area FLS-4S 0080541

POS flash dongle, for APAC area FLS-4S 0080542

Not in pic-
ture

Service SW N.A.

Not in pic-
ture

Opening tool (upper part) SRT-4 0770286

Not in pic-
ture

Opening tool (Lower part) SRT-5 0770444
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Energy Management and Proximity sensor Calibrations and RF Testing (Assembled phone)

Figure 3: Equipment for NHL-2NA energy management and proximity sensor calibrations and RF testing.

MJF-7 includes also white light source which can be used for Camera image quality
checking. Note, RF tuning is not allowed with CPL-5 coupler, it can be used only to test
RF.

Item: Service accessory Product code

1 Docking station JBV-1 0770298

2 Docking station adapter MJF-7 0775285

3 DC power cable PCS-1 0730012

4 RF Coupler CPL-5 0770370

5 Service Cable DAU-9S 0730108 

6 RF Cable XRF-1 0730085

7 DC Cable SCB-3 0730114

8 Software protection key PKD-1 0750018

Not in picture Service SW N.A.

Not in picture Opening tool (upper part) SRT-4 0770286

Not in picture Opening tool (Lower part) SRT-5 0770444
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Component level fault finding equipment:
Figure 4: MJS-9Q module jig is used for component level fault finding. RF tuning and SW update of disassembled 

phone is also possible.

Item: Service accessory Product code

1 Module jig MJS-9Q 0775284

2 DC power cable PCS-1 0730012

3 RF antenna cable XRF-1 0730085

4 Service MBUS cable DAU-9S 0730108

5 Software protection key PKD-1 0750018

Not in picture Service SW N.A.

Not in picture Opening tool (upper part) SRT-4 0770286

Not in picture Opening tool (Lower part) SRT-5 0770444

Not in picture Opening tool ‘button type’ SRT-6 0770431
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Assembled Phone RF Tuning and Ambient Light Sensor Calibration Equipment 
Figure 5: Equipment for NHL-2NA RF tuning and ambient light sensor calibration.

Note: RA7 can be used instead of TDS-10. RA7 is less expensive but its use requires opening four 
transceiver screws every time you use it.

Item: Service accessory Product code

1  JBV-1, Docking station 0770298

2 MJF-7, Docking station adapter 0775285

3 TDS-10 GSM RF Probe for RF tuning 0770436

4 TDS-11 Calibration lamp 0770440

5 XRF-1, RF antenna cable 0730085

6 PCS-1, DC power cable 0730012

7 DAU-9S, Service MBUS cable 0730108

8 PKD-1, Software protection key 0750018

- RF adapter for NHL-2NA RA7 0770443

Not in picture Service SW N.A.

Not in picture Opening tool (upper part) SRT-4 0770286

Not in picture Opening tool (Lower part) SRT-5 0770444
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SW update using FPS-8C, JBV-1 and MJF-7
Figure 6: NHL-2NANHL-2NA SW update using FPS-8C, JBV-1 and MJF-7

Item: Service accessory Product code

1 Docking station adapter (8 pcs needed) MJF-7 0775285 (Code 
includes one piece)

2 Docking station (8 pcs needed) JBV-1 0770298 (Code 
includes one piece)

3 Modular cable (8 pcs needed) XCS-4 0730178 (Code 
includes one piece)

4 DC power cable (8 pcs needed) PCS-1 0730012 (Code 
includes one piece)

5 FPS-8C (one piece needed) FPS-8C 0080396

Not in picture SRAM Module (16 pcs needed inside FPS-
8C)

SF12 0080346 (Code 
includes one SRAM 
module)

Not in picture D9 – D9 cable, incl in FPS-8C sales pack (1 
Pc needed)

AXS-4 0730090

Not in picture Printer cable, incl in FPS-8C sales pack (1 
Pc needed)

AXP-8 N.A.

Not in picture Software protection key PKD-1 0750018

Not in picture SW, Software (PC SW + SF11C SW) - N.A.
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NHL-2NA Bluetooth Testing
Figure 7: Equipment needed to perform NHL-2NA BT BER test.

Alternatively, MJF-7 + JBV-1 combination can be used instead of FLA-21.

Item: Service accessory Product code

1  Point of Sales flash loading adapter FLA-21 0775283

2 Service MBUS cable DAU-9S 0730108

3 Test- & IF-Box Bluetooth JBT-9 0770336

4,5 Power supply for JBT-9 and for FLA-21 ACP-8* N.A.
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Appendix

Frequency mappings
The following figure shows the RX/TX operating frequency mapping to the frequency
synthesizer operating frequency. For a more detailed list of actual channel number map-
pings see below.

Figure 8: VCO frequency mappings

Table 1  - E-GSM900 Channel to VCO operating frequency mapping

Ch TX RX VCO 
TX

VCO 
RX

C
h TX RX VCO 

TX
VCO 
RX Ch TX RX VCO 

TX
VCO 
RX

975 880.2 925.2 3520.8 3700.8 1 890.2 935.2 3560.8 3740.8 63 902.6 947.6 3610.4 3790.4

976 880.4 925.4 3521.6 3701.6 2 890.4 935.4 3561.6 3741.6 64 902.8 947.8 3611.2 3791.2

977 880.6 925.6 3522.4 3702.4 3 890.6 935.6 3562.4 3742.4 65 903 948 3612 3792

978 880.8 925.8 3523.2 3703.2 4 890.8 935.8 3563.2 3743.2 66 903.2 948.2 3612.8 3792.8

979 881 926 3524 3704 5 891 936 3564 3744 67 903.4 948.4 3613.6 3793.6

980 881.2 926.2 3524.8 3704.8 6 891.2 936.2 3564.8 3744.8 68 903.6 948.6 3614.4 3794.4

981 881.4 926.4 3525.6 3705.6 7 891.4 936.4 3565.6 3745.6 69 903.8 948.8 3615.2 3795.2

982 881.6 926.6 3526.4 3706.4 8 891.6 936.6 3566.4 3746.4 70 904 949 3616 3796

983 881.8 926.8 3527.2 3707.2 9 891.8 936.8 3567.2 3747.2 71 904.2 949.2 3616.8 3796.8

984 882 927 3528 3708 10 892 937 3568 3748 72 904.4 949.4 3617.6 3797.6

985 882.2 927.2 3528.8 3708.8 11 892.2 937.2 3568.8 3748.8 73 904.6 949.6 3618.4 3798.4

986 882.4 927.4 3529.6 3709.6 12 892.4 937.4 3569.6 3749.6 74 904.8 949.8 3619.2 3799.2

987 882.6 927.6 3530.4 3710.4 13 892.6 937.6 3570.4 3750.4 75 905 950 3620 3800

988 882.8 927.8 3531.2 3711.2 14 892.8 937.8 3571.2 3751.2 76 905.2 950.2 3620.8 3800.8

989 883 928 3532 3712 15 893 938 3572 3752 77 905.4 950.4 3621.6 3801.6

990 883.2 928.2 3532.8 3712.8 16 893.2 938.2 3572.8 3752.8 78 905.6 950.6 3622.4 3802.4

991 883.4 928.4 3533.6 3713.6 17 893.4 938.4 3573.6 3753.6 79 905.8 950.8 3623.2 3803.2

992 883.6 928.6 3534.4 3714.4 18 893.6 938.6 3574.4 3754.4 80 906 951 3624 3804

993 883.8 928.8 3535.2 3715.2 19 893.8 938.8 3575.2 3755.2 81 906.2 951.2 3624.8 3804.8

994 884 929 3536 3716 20 894 939 3576 3756 82 906.4 951.4 3625.6 3805.6

995 884.2 929.2 3536.8 3716.8 21 894.2 939.2 3576.8 3756.8 83 906.6 951.6 3626.4 3806.4

996 884.4 929.4 3537.6 3717.6 22 894.4 939.4 3577.6 3757.6 84 906.8 951.8 3627.2 3807.2
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997 884.6 929.6 3538.4 3718.4 23 894.6 939.6 3578.4 3758.4 85 907 952 3628 3808

998 884.8 929.8 3539.2 3719.2 24 894.8 939.8 3579.2 3759.2 86 907.2 952.2 3628.8 3808.8

999 885 930 3540 3720 25 895 940 3580 3760 87 907.4 952.4 3629.6 3809.6

1000 885.2 930.2 3540.8 3720.8 26 895.2 940.2 3580.8 3760.8 88 907.6 952.6 3630.4 3810.4

1001 885.4 930.4 3541.6 3721.6 27 895.4 940.4 3581.6 3761.6 89 907.8 952.8 3631.2 3811.2

1002 885.6 930.6 3542.4 3722.4 28 895.6 940.6 3582.4 3762.4 90 908 953 3632 3812

1003 885.8 930.8 3543.2 3723.2 29 895.8 940.8 3583.2 3763.2 91 908.2 953.2 3632.8 3812.8

1004 886 931 3544 3724 30 896 941 3584 3764 92 908.4 953.4 3633.6 3813.6

1005 886.2 931.2 3544.8 3724.8 31 896.2 941.2 3584.8 3764.8 93 908.6 953.6 3634.4 3814.4

1006 886.4 931.4 3545.6 3725.6 32 896.4 941.4 3585.6 3765.6 94 908.8 953.8 3635.2 3815.2

1007 886.6 931.6 3546.4 3726.4 33 896.6 941.6 3586.4 3766.4 95 909 954 3636 3816

1008 886.8 931.8 3547.2 3727.2 34 896.8 941.8 3587.2 3767.2 96 909.2 954.2 3636.8 3816.8

1009 887 932 3548 3728 35 897 942 3588 3768 97 909.4 954.4 3637.6 3817.6

1010 887.2 932.2 3548.8 3728.8 36 897.2 942.2 3588.8 3768.8 98 909.6 954.6 3638.4 3818.4

1011 887.4 932.4 3549.6 3729.6 37 897.4 942.4 3589.6 3769.6 99 909.8 954.8 3639.2 3819.2

1012 887.6 932.6 3550.4 3730.4 38 897.6 942.6 3590.4 3770.4 100 910 955 3640 3820

1013 887.8 932.8 3551.2 3731.2 39 897.8 942.8 3591.2 3771.2 101 910.2 955.2 3640.8 3820.8

1014 888 933 3552 3732 40 898 943 3592 3772 102 910.4 955.4 3641.6 3821.6

1015 888.2 933.2 3552.8 3732.8 41 898.2 943.2 3592.8 3772.8 103 910.6 955.6 3642.4 3822.4

1016 888.4 933.4 3553.6 3733.6 42 898.4 943.4 3593.6 3773.6 104 910.8 955.8 3643.2 3823.2

1017 888.6 933.6 3554.4 3734.4 43 898.6 943.6 3594.4 3774.4 105 911 956 3644 3824

1018 888.8 933.8 3555.2 3735.2 44 898.8 943.8 3595.2 3775.2 106 911.2 956.2 3644.8 3824.8

1019 889 934 3556 3736 45 899 944 3596 3776 107 911.4 956.4 3645.6 3825.6

1020 889.2 934.2 3556.8 3736.8 46 899.2 944.2 3596.8 3776.8 108 911.6 956.6 3646.4 3826.4

1021 889.4 934.4 3557.6 3737.6 47 899.4 944.4 3597.6 3777.6 109 911.8 956.8 3647.2 3827.2

1022 889.6 934.6 3558.4 3738.4 48 899.6 944.6 3598.4 3778.4 110 912 957 3648 3828

1023 889.8 934.8 3559.2 3739.2 49 899.8 944.8 3599.2 3779.2 111 912.2 957.2 3648.8 3828.8

0 890 935 3560 3740 50 900 945 3600 3780 112 912.4 957.4 3649.6 3829.6

51 900.2 945.2 3600.8 3780.8 113 912.6 957.6 3650.4 3830.4

52 900.4 945.4 3601.6 3781.6 114 912.8 957.8 3651.2 3831.2

53 900.6 945.6 3602.4 3782.4 115 913 958 3652 3832

54 900.8 945.8 3603.2 3783.2 116 913.2 958.2 3652.8 3832.8

55 901 946 3604 3784 117 913.4 958.4 3653.6 3833.6

56 901.2 946.2 3604.8 3784.8 118 913.6 958.6 3654.4 3834.4

57 901.4 946.4 3605.6 3785.6 119 913.8 958.8 3655.2 3835.2

58 901.6 946.6 3606.4 3786.4 120 914 959 3656 3836

59 901.8 946.8 3607.2 3787.2 121 914.2 959.2 3656.8 3836.8

60 902 947 3608 3788 122 914.4 959.4 3657.6 3837.6

61 902.2 947.2 3608.8 3788.8 123 914.6 959.6 3658.4 3838.4

62 902.4 947.4 3609.6 3789.6 124 914.8 959.8 3659.2 3839.2
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Table 2 – GSM1800 Channel to VCO operating frequency mapping 

Ch TX RX VCO 
TX

VCO 
RX Ch TX RX VCO 

TX
VCO 
RX Ch TX RX VCO 

TX
VCO 
RX

512 1710.2 1805.
2

3420.4 3610.
4

638 1735.4 1830.4 3470.8 3660.8 764 1760.6 1855.6 3521.2 3711.2

513 1710.4 1805.
4

6841.6 7221.
6

639 1735.6 1830.6 3471.2 3661.2 765 1760.8 1855.8 3521.6 3711.6

514 1710.6 1805.
6

6842.4 7222.
4

640 1735.8 1830.8 3471.6 3661.6 766 1761 1856 3522 3712

515 1710.8 1805.
8

6843.2 7223.
2

641 1736 1831 3472 3662 767 1761.2 1856.2 3522.4 3712.4

516 1711 1806 6844 7224 642 1736.2 1831.2 3472.4 3662.4 768 1761.4 1856.4 3522.8 3712.8

517 1711.2 1806.
2

6844.8 7224.
8

643 1736.4 1831.4 3472.8 3662.8 769 1761.6 1856.6 3523.2 3713.2

518 1711.4 1806.
4

6845.6 7225.
6

644 1736.6 1831.6 3473.2 3663.2 770 1761.8 1856.8 3523.6 3713.6

519 1711.6 1806.
6

6846.4 7226.
4

645 1736.8 1831.8 3473.6 3663.6 771 1762 1857 3524 3714

520 1711.8 1806.
8

6847.2 7227.
2

646 1737 1832 3474 3664 772 1762.2 1857.2 3524.4 3714.4

521 1712 1807 6848 7228 647 1737.2 1832.2 3474.4 3664.4 773 1762.4 1857.4 3524.8 3714.8

522 1712.2 1807.
2

6848.8 7228.
8

648 1737.4 1832.4 3474.8 3664.8 774 1762.6 1857.6 3525.2 3715.2

523 1712.4 1807.
4

6849.6 7229.
6

649 1737.6 1832.6 3475.2 3665.2 775 1762.8 1857.8 3525.6 3715.6

524 1712.6 1807.
6

6850.4 7230.
4

650 1737.8 1832.8 3475.6 3665.6 776 1763 1858 3526 3716

525 1712.8 1807.
8

6851.2 7231.
2

651 1738 1833 3476 3666 777 1763.2 1858.2 3526.4 3716.4

526 1713 1808 6852 7232 652 1738.2 1833.2 3476.4 3666.4 778 1763.4 1858.4 3526.8 3716.8

527 1713.2 1808.
2

6852.8 7232.
8

653 1738.4 1833.4 3476.8 3666.8 779 1763.6 1858.6 3527.2 3717.2

528 1713.4 1808.
4

6853.6 7233.
6

654 1738.6 1833.6 3477.2 3667.2 780 1763.8 1858.8 3527.6 3717.6

529 1713.6 1808.
6

6854.4 7234.
4

655 1738.8 1833.8 3477.6 3667.6 781 1764 1859 3528 3718

530 1713.8 1808.
8

6855.2 7235.
2

656 1739 1834 3478 3668 782 1764.2 1859.2 3528.4 3718.4

531 1714 1809 6856 7236 657 1739.2 1834.2 3478.4 3668.4 783 1764.4 1859.4 3528.8 3718.8

532 1714.2 1809.
2

6856.8 7236.
8

658 1739.4 1834.4 3478.8 3668.8 784 1764.6 1859.6 3529.2 3719.2

533 1714.4 1809.
4

6857.6 7237.
6

659 1739.6 1834.6 3479.2 3669.2 785 1764.8 1859.8 3529.6 3719.6

534 1714.6 1809.
6

6858.4 7238.
4

660 1739.8 1834.8 3479.6 3669.6 786 1765 1860 3530 3720

535 1714.8 1809.
8

6859.2 7239.
2

661 1740 1835 3480 3670 787 1765.2 1860.2 3530.4 3720.4

536 1715 1810 6860 7240 662 1740.2 1835.2 3480.4 3670.4 788 1765.4 1860.4 3530.8 3720.8

537 1715.2 1810.
2

6860.8 7240.
8

663 1740.4 1835.4 3480.8 3670.8 789 1765.6 1860.6 3531.2 3721.2
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538 1715.4 1810.
4

6861.6 7241.
6

664 1740.6 1835.6 3481.2 3671.2 790 1765.8 1860.8 3531.6 3721.6

539 1715.6 1810.
6

6862.4 7242.
4

665 1740.8 1835.8 3481.6 3671.6 791 1766 1861 3532 3722

540 1715.8 1810.
8

6863.2 7243.
2

666 1741 1836 3482 3672 792 1766.2 1861.2 3532.4 3722.4

541 1716 1811 6864 7244 667 1741.2 1836.2 3482.4 3672.4 793 1766.4 1861.4 3532.8 3722.8

542 1716.2 1811.2 6864.8 7244.
8

668 1741.4 1836.4 3482.8 3672.8 794 1766.6 1861.6 3533.2 3723.2

543 1716.4 1811.4 6865.6 7245.
6

669 1741.6 1836.6 3483.2 3673.2 795 1766.8 1861.8 3533.6 3723.6

544 1716.6 1811.6 6866.4 7246.
4

670 1741.8 1836.8 3483.6 3673.6 796 1767 1862 3534 3724

545 1716.8 1811.8 6867.2 7247.
2

671 1742 1837 3484 3674 797 1767.2 1862.2 3534.4 3724.4

546 1717 1812 6868 7248 672 1742.2 1837.2 3484.4 3674.4 798 1767.4 1862.4 3534.8 3724.8

547 1717.2 1812.
2

6868.8 7248.
8

673 1742.4 1837.4 3484.8 3674.8 799 1767.6 1862.6 3535.2 3725.2

548 1717.4 1812.
4

6869.6 7249.
6

674 1742.6 1837.6 3485.2 3675.2 800 1767.8 1862.8 3535.6 3725.6

549 1717.6 1812.
6

6870.4 7250.
4

675 1742.8 1837.8 3485.6 3675.6 801 1768 1863 3536 3726

550 1717.8 1812.
8

6871.2 7251.
2

676 1743 1838 3486 3676 802 1768.2 1863.2 3536.4 3726.4

551 1718 1813 6872 7252 677 1743.2 1838.2 3486.4 3676.4 803 1768.4 1863.4 3536.8 3726.8

552 1718.2 1813.
2

6872.8 7252.
8

678 1743.4 1838.4 3486.8 3676.8 804 1768.6 1863.6 3537.2 3727.2

553 1718.4 1813.
4

6873.6 7253.
6

679 1743.6 1838.6 3487.2 3677.2 805 1768.8 1863.8 3537.6 3727.6

554 1718.6 1813.
6

6874.4 7254.
4

680 1743.8 1838.8 3487.6 3677.6 806 1769 1864 3538 3728

555 1718.8 1813.
8

6875.2 7255.
2

681 1744 1839 3488 3678 807 1769.2 1864.2 3538.4 3728.4

556 1719 1814 6876 7256 682 1744.2 1839.2 3488.4 3678.4 808 1769.4 1864.4 3538.8 3728.8

557 1719.2 1814.
2

6876.8 7256.
8

683 1744.4 1839.4 3488.8 3678.8 809 1769.6 1864.6 3539.2 3729.2

558 1719.4 1814.
4

6877.6 7257.
6

684 1744.6 1839.6 3489.2 3679.2 810 1769.8 1864.8 3539.6 3729.6

559 1719.6 1814.
6

6878.4 7258.
4

685 1744.8 1839.8 3489.6 3679.6 811 1770 1865 3540 3730

560 1719.8 1814.
8

6879.2 7259.
2

686 1745 1840 3490 3680 812 1770.2 1865.2 3540.4 3730.4

561 1720 1815 6880 7260 687 1745.2 1840.2 3490.4 3680.4 813 1770.4 1865.4 3540.8 3730.8

562 1720.2 1815.
2

6880.8 7260.
8

688 1745.4 1840.4 3490.8 3680.8 814 1770.6 1865.6 3541.2 3731.2

563 1720.4 1815.
4

6881.6 7261.
6

689 1745.6 1840.6 3491.2 3681.2 815 1770.8 1865.8 3541.6 3731.6

564 1720.6 1815.
6

6882.4 7262.
4

690 1745.8 1840.8 3491.6 3681.6 816 1771 1866 3542 3732

565 1720.8 1815.
8

6883.2 7263.
2

691 1746 1841 3492 3682 817 1771.2 1866.2 3542.4 3732.4

566 1721 1816 6884 7264 692 1746.2 1841.2 3492.4 3682.4 818 1771.4 1866.4 3542.8 3732.8
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567 1721.2 1816.
2

6884.8 7264.
8

693 1746.4 1841.4 3492.8 3682.8 819 1771.6 1866.6 3543.2 3733.2

568 1721.4 1816.
4

6885.6 7265.
6

694 1746.6 1841.6 3493.2 3683.2 820 1771.8 1866.8 3543.6 3733.6

569 1721.6 1816.
6

6886.4 7266.
4

695 1746.8 1841.8 3493.6 3683.6 821 1772 1867 3544 3734

570 1721.8 1816.
8

6887.2 7267.
2

696 1747 1842 3494 3684 822 1772.2 1867.2 3544.4 3734.4

571 1722 1817 6888 7268 697 1747.2 1842.2 3494.4 3684.4 823 1772.4 1867.4 3544.8 3734.8

572 1722.2 1817.
2

6888.8 7268.
8

698 1747.4 1842.4 3494.8 3684.8 824 1772.6 1867.6 3545.2 3735.2

573 1722.4 1817.
4

6889.6 7269.
6

699 1747.6 1842.6 3495.2 3685.2 825 1772.8 1867.8 3545.6 3735.6

574 1722.6 1817.
6

6890.4 7270.
4

700 1747.8 1842.8 3495.6 3685.6 826 1773 1868 3546 3736

575 1722.8 1817.
8

3445.6 3635.
6

701 1748 1843 3496 3686 827 1773.2 1868.2 3546.4 3736.4

576 1723 1818 3446 3636 702 1748.2 1843.2 3496.4 3686.4 828 1773.4 1868.4 3546.8 3736.8

577 1723.2 1818.
2

3446.4 3636.
4

703 1748.4 1843.4 3496.8 3686.8 829 1773.6 1868.6 3547.2 3737.2

578 1723.4 1818.
4

3446.8 3636.
8

704 1748.6 1843.6 3497.2 3687.2 830 1773.8 1868.8 3547.6 3737.6

579 1723.6 1818.
6

3447.2 3637.
2

705 1748.8 1843.8 3497.6 3687.6 831 1774 1869 3548 3738

580 1723.8 1818.
8

3447.6 3637.
6

706 1749 1844 3498 3688 832 1774.2 1869.2 3548.4 3738.4

581 1724 1819 3448 3638 707 1749.2 1844.2 3498.4 3688.4 833 1774.4 1869.4 3548.8 3738.8

582 1724.2 1819.
2

3448.4 3638.
4

708 1749.4 1844.4 3498.8 3688.8 834 1774.6 1869.6 3549.2 3739.2

583 1724.4 1819.
4

3448.8 3638.
8

709 1749.6 1844.6 3499.2 3689.2 835 1774.8 1869.8 3549.6 3739.6

584 1724.6 1819.
6

3449.2 3639.
2

710 1749.8 1844.8 3499.6 3689.6 836 1775 1870 3550 3740

585 1724.8 1819.
8

3449.6 3639.
6

711 1750 1845 3500 3690 837 1775.2 1870.2 3550.4 3740.4

586 1725 1820 3450 3640 712 1750.2 1845.2 3500.4 3690.4 838 1775.4 1870.4 3550.8 3740.8

587 1725.2 1820.
2

3450.4 3640.
4

713 1750.4 1845.4 3500.8 3690.8 839 1775.6 1870.6 3551.2 3741.2

588 1725.4 1820.
4

3450.8 3640.
8

714 1750.6 1845.6 3501.2 3691.2 840 1775.8 1870.8 3551.6 3741.6

589 1725.6 1820.
6

3451.2 3641.
2

715 1750.8 1845.8 3501.6 3691.6 841 1776 1871 3552 3742

590 1725.8 1820.
8

3451.6 3641.
6

716 1751 1846 3502 3692 842 1776.2 1871.2 3552.4 3742.4

591 1726 1821 3452 3642 717 1751.2 1846.2 3502.4 3692.4 843 1776.4 1871.4 3552.8 3742.8

592 1726.2 1821.
2

3452.4 3642.
4

718 1751.4 1846.4 3502.8 3692.8 844 1776.6 1871.6 3553.2 3743.2

593 1726.4 1821.
4

3452.8 3642.
8

719 1751.6 1846.6 3503.2 3693.2 845 1776.8 1871.8 3553.6 3743.6

594 1726.6 1821.
6

3453.2 3643.
2

720 1751.8 1846.8 3503.6 3693.6 846 1777 1872 3554 3744
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595 1726.8 1821.
8

3453.6 3643.
6

721 1752 1847 3504 3694 847 1777.2 1872.2 3554.4 3744.4

596 1727 1822 3454 3644 722 1752.2 1847.2 3504.4 3694.4 848 1777.4 1872.4 3554.8 3744.8

597 1727.2 1822.
2

3454.4 3644.
4

723 1752.4 1847.4 3504.8 3694.8 849 1777.6 1872.6 3555.2 3745.2

598 1727.4 1822.
4

3454.8 3644.
8

724 1752.6 1847.6 3505.2 3695.2 850 1777.8 1872.8 3555.6 3745.6

599 1727.6 1822.
6

3455.2 3645.
2

725 1752.8 1847.8 3505.6 3695.6 851 1778 1873 3556 3746

600 1727.8 1822.
8

3455.6 3645.
6

726 1753 1848 3506 3696 852 1778.2 1873.2 3556.4 3746.4

601 1728 1823 3456 3646 727 1753.2 1848.2 3506.4 3696.4 853 1778.4 1873.4 3556.8 3746.8

602 1728.2 1823.
2

3456.4 3646.
4

728 1753.4 1848.4 3506.8 3696.8 854 1778.6 1873.6 3557.2 3747.2

603 1728.4 1823.
4

3456.8 3646.
8

729 1753.6 1848.6 3507.2 3697.2 855 1778.8 1873.8 3557.6 3747.6

604 1728.6 1823.
6

3457.2 3647.
2

730 1753.8 1848.8 3507.6 3697.6 856 1779 1874 3558 3748

605 1728.8 1823.
8

3457.6 3647.
6

731 1754 1849 3508 3698 857 1779.2 1874.2 3558.4 3748.4

606 1729 1824 3458 3648 732 1754.2 1849.2 3508.4 3698.4 858 1779.4 1874.4 3558.8 3748.8

607 1729.2 1824.
2

3458.4 3648.
4

733 1754.4 1849.4 3508.8 3698.8 859 1779.6 1874.6 3559.2 3749.2

608 1729.4 1824.
4

3458.8 3648.
8

734 1754.6 1849.6 3509.2 3699.2 860 1779.8 1874.8 3559.6 3749.6

609 1729.6 1824.
6

3459.2 3649.
2

735 1754.8 1849.8 3509.6 3699.6 861 1780 1875 3560 3750

610 1729.8 1824.
8

3459.6 3649.
6

736 1755 1850 3510 3700 862 1780.2 1875.2 3560.4 3750.4

611 1730 1825 3460 3650 737 1755.2 1850.2 3510.4 3700.4 863 1780.4 1875.4 3560.8 3750.8

612 1730.2 1825.
2

3460.4 3650.
4

738 1755.4 1850.4 3510.8 3700.8 864 1780.6 1875.6 3561.2 3751.2

613 1730.4 1825.
4

3460.8 3650.
8

739 1755.6 1850.6 3511.2 3701.2 865 1780.8 1875.8 3561.6 3751.6

614 1730.6 1825.
6

3461.2 3651.
2

740 1755.8 1850.8 3511.6 3701.6 866 1781 1876 3562 3752

615 1730.8 1825.
8

3461.6 3651.
6

741 1756 1851 3512 3702 867 1781.2 1876.2 3562.4 3752.4

616 1731 1826 3462 3652 742 1756.2 1851.2 3512.4 3702.4 868 1781.4 1876.4 3562.8 3752.8

617 1731.2 1826.
2

3462.4 3652.
4

743 1756.4 1851.4 3512.8 3702.8 869 1781.6 1876.6 3563.2 3753.2

618 1731.4 1826.
4

3462.8 3652.
8

744 1756.6 1851.6 3513.2 3703.2 870 1781.8 1876.8 3563.6 3753.6

619 1731.6 1826.
6

3463.2 3653.
2

745 1756.8 1851.8 3513.6 3703.6 871 1782 1877 3564 3754

620 1731.8 1826.
8

3463.6 3653.
6

746 1757 1852 3514 3704 872 1782.2 1877.2 3564.4 3754.4

621 1732 1827 3464 3654 747 1757.2 1852.2 3514.4 3704.4 873 1782.4 1877.4 3564.8 3754.8

622 1732.2 1827.
2

3464.4 3654.
4

748 1757.4 1852.4 3514.8 3704.8 874 1782.6 1877.6 3565.2 3755.2

623 1732.4 1827.
4

3464.8 3654.
8

749 1757.6 1852.6 3515.2 3705.2 875 1782.8 1877.8 3565.6 3755.6
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624 1732.6 1827.
6

3465.2 3655.
2

750 1757.8 1852.8 3515.6 3705.6 876 1783 1878 3566 3756

625 1732.8 1827.
8

3465.6 3655.
6

751 1758 1853 3516 3706 877 1783.2 1878.2 3566.4 3756.4

626 1733 1828 3466 3656 752 1758.2 1853.2 3516.4 3706.4 878 1783.4 1878.4 3566.8 3756.8

627 1733.2 1828.
2

3466.4 3656.
4

753 1758.4 1853.4 3516.8 3706.8 879 1783.6 1878.6 3567.2 3757.2

628 1733.4 1828.
4

3466.8 3656.
8

754 1758.6 1853.6 3517.2 3707.2 880 1783.8 1878.8 3567.6 3757.6

629 1733.6 1828.
6

3467.2 3657.
2

755 1758.8 1853.8 3517.6 3707.6 881 1784 1879 3568 3758

630 1733.8 1828.
8

3467.6 3657.
6

756 1759 1854 3518 3708 882 1784.2 1879.2 3568.4 3758.4

631 1734 1829 3468 3658 757 1759.2 1854.2 3518.4 3708.4 883 1784.4 1879.4 3568.8 3758.8

632 1734.2 1829.
2

3468.4 3658.
4

758 1759.4 1854.4 3518.8 3708.8 884 1784.6 1879.6 3569.2 3759.2

633 1734.4 1829.
4

3468.8 3658.
8

759 1759.6 1854.6 3519.2 3709.2 885 1784.8 1879.8 3569.6 3759.6

634 1734.6 1829.
6

3469.2 3659.
2

760 1759.8 1854.8 3519.6 3709.6

635 1734.8 1829.
8

3469.6 3659.
6

761 1760 1855 3520 3710

636 1735 1830 3470 3660 762 1760.2 1855.2 3520.4 3710.4

637 1735.2 1830.
2

3470.4 3660.
4

763 1760.4 1855.4 3520.8 3710.8
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